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Счего начинается web-дизайн? Как

и любой другой творческий про-

цесс, он начинается с разработки

оригинальной, ни на что не похожей

идеи. Поэтому важно уяснить, что все

средства, от элементарных до самых со-

временных, не что иное, как только

кисть, инструмент, позволяющий эту

самую гнездящуюся в светлой голове

дизайнера идею воплотить на экране

монитора.

Вот уже четырнадцать лет существуют

Всемирная паутина и язык HTML. За

это время появилось множество web-

стандартов и всевозможных средств раз-

работки. Самые современные, как уже

говорилось, предоставляют возмож-

ность даже без знания каких-либо язы-

ков разметки, просто с помощью визу-

альных настроек изменять уже сущест-

вующие шаблоны и одним нажатием

кнопки мыши генерировать целые сай-

ты. Только вот, как мне кажется, это уже

не творчество, а ремесленничество, по-

точное производство, так сказать. 

Вообще, средства web-разработки ус-

ловно можно разделить на три категории: 

3 текстовые (вроде Блокнота), где весь

код интернет-документа вводится вруч-

ную, и единственное отличие от стан-

дартного Блокнота порой заключается

лишь только в подсветке тэгов; 

3 собственно тэговые редакторы, к кото-

рым и относится программа HotDog

Professional, позволяющие автоматизи-

ровать наиболее рутинные операции,

предлагая пользователю множество по-

лезных возможностей и одновременно

ничем не ограничивая его фантазию;

3 визуальные редакторы, с по-

мощью которых любой,

даже начинающий пользо-

ватель, более-менее владе-

ющий клавиатурой и

мышкой, создаст сайт

среднего уровня. 

Правда, большинство ви-

зуальных средств имеют круп-

ный недостаток: не совсем

правильно форматируя документ,

они добавляют в него большое количест-

во ненужных тэгов, что способно в не-

сколько раз увеличить размер документа

и, соответственно, скорость его загрузки. 

ÇÍÛÒÌ˚È
HTML

Сегодня все больше появляется различных программ для работы
с HTML-документами. Однако многие старые и испытанные
средства, такие как редактор HotDog Professional, не сдают своих
позиций, а наоборот, динамично развиваются и постоянно при-
обретают новых пользователей.
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Так что наиболее предпочтительные

инструменты — именно тэговые редак-

торы. Благодаря им можно не утруждать

себя выполнением механических опе-

раций и одновременно иметь возмож-

ность контролировать всю структуру

редактируемого файла. 

На заре сайтостроения не так уж мно-

го было подобных программ, начиная с

первой версии, вышедшей в июне 1995

года, HotDog c его неизменным симво-

лом — веселой зеленой собачкой — по

праву считается одним из признанных

лидеров в этой области. По возрасту и

популярности с ним может сравниться

разве что HomeSite. Но судьба последне-

го после его приобретения компанией

Macromedia остается под большим во-

просом, а HotDog продолжает успешно

развиваться и в этом году порадовал

пользователей выходом седьмой версии.

Итак, давайте на его примере рассмот-

рим, что же представляет собой сегодня

современный тэговый HTML-редактор.

Сразу же оговоримся, что данная статья

отнюдь не претендует на руководство

пользователя. Мы ставим иные цели:

рассказать начинающим web-мастерам

(опытным, надеемся, программа хорошо

известна) об основных и наиболее инте-

ресных возможностях и достоинствах

редактора HotDog.

á‡ÍÎ‡‰˚‚‡ÂÏ ÙÛÌ‰‡ÏÂÌÚ
По традиции интерфейс таких приложе-

ний состоит из двух частей — собственно

окна редактирования HTML-документа

и средства предварительного просмотра,

некоего встроенного браузера, работаю-

щего как на основе Microsoft Internet

Explorer, так и собственного ориги-

нального HTML-вьювера. HotDog не

исключение.

Создание нового файла сопро-

вождается запуском мастера, пред-

лагающего указать основные

свойства документа (цвет фо-

на, текста, ссылок и т. д.).

Можно ввести все пара-

метры сразу, а можно и

пропустить этот шаг, вернувшись к нему

в дальнейшем. Если нужно превратить

в гипертекстовый документ обычный

текст — к вашим услугам удобный мо-

дуль импортирования, вызываемый че-

рез меню «File –> Import Text Docu-

ment» или соответствующей кнопкой

на панели инструментов.

Итак, базовый код нашего документа

создан. Обратим внимание — здесь нет

ничего лишнего, даже не выставляется

автоматически метатэг с кодировкой

ISO-866, чем, как правило, грешат анало-

гичные западные продукты и что достав-

ляет пускай мелкие, но все же неприятно-

сти русскоязычным пользователям. 

Далее следует решить, будет ли созда-

ваемый HTML-документ иметь фреймо-

вую структуру или нет. Разработчики до

предела облегчили задачу установки

фреймов благодаря специальному мас-

теру «Frame –> Frame Wizard». Он про-

ведет через весь процесс разбиения до-

кумента на фреймы, предложит указать

их количество, расположение, URL каж-

дого из них, а также создать специаль-

ную ссылку для тех браузеров, которые

не могут отображать фреймы.

Одним из наиболее распространенных

до сих пор способов структурирования

web-документа является форматирова-

ние с помощью невидимой таблицы. И в

этом случае программа предлагает сразу

несколько путей для решения этой зада-

чи. Самый простой и легкий — Table Wi-

zard, полуавтоматический Quick Table,

несколько напоминающий создание

таблиц в Microsoft Word и простую встав-

ку табличных тэгов. Для любителей фор-

матирования документа с помощью кас-

кадных таблиц стилей имеется специ-

альный модуль для быстрой вставки тэ-

гов CSS. Стилевую таблицу можно вста-

вить в тело документа, а можно и создать

отдельный файл, поставив в основном

документе ссылку на него. Сразу ска-

жем, что практически все функции Hot-

Dog реализованы по одному и тому же

принципу — можно воспользоваться ма-

стером, а можно и ограничиться простой

вставкой тэгов. Тем самым разработчики

постарались учесть как можно больше

вкусов и привычек пользователей. 

Как уже говорилось выше, при гене-

рировании базового кода не создается

ничего лишнего, то есть все метатэги

пользователь может вставить впоследст-

вии сам, выбрав именно те, которые ему

нужны. Это может быть и информация о

создателе страницы, краткое описание

для поисковых машин, ключевые слова

и многое другое. Создавать метатэги

лучше всего с помощью специального

модуля («Format -> Document Informati-

on»), который состоит из нескольких

вкладок и, на мой взгляд, даже более

удобен, чем пошаговые мастера, сопро-

вождающие все основные операции. 

ÑÎfl ÔËÒ‡ÚÂÎÂÈ
Теперь скелет документа создан, и наша

фантазия по его заполнению ничем не

ограничена. Разработчики HotDog при-

готовили самые разнообразные средст-

ва для этой цели. Только сразу преду-

предим — для редактирования и быст-

рого просмотра его результатов доку-

мент необходимо сразу же предвари-

тельно сохранить. Иначе многие инст-

рументы будут попросту недоступны.

По умолчания предлагается сохранение

в формате HotDog Template (TPL), но

можно выбрать и другие форматы

(HTML, PHP, ASP, JavaScript, VBScript). 
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HotDog Professional

í‡Í ‚˚„Îfl‰ÂÎ‡ ÔÂ‚‡fl ‚ÂÒËfl HotDog 3

»

HotDog Professional

ê‡Á‡·ÓÚ˜ËÍ 3 Sausage Software

ë‡ÈÚ ‡Á‡·ÓÚ˜ËÍ‡ 3 www.sausage.com

ìÒÎÓ‚Ëfl ‡ÒÔÓÒÚ‡ÌÂÌËfl 3 shareware

ëÚÓËÏÓÒÚ¸ 3 $99 (˜ÂÂÁ àÌÚÂÌÂÚ), $129 (Ì‡ CD)
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Функции форматирования текста пред-

ставлены в программе в полном объеме.

Это создание заголовков различных уров-

ней, выравнивание абзацев, возможность

изменять размер и начертание шрифта и

т. д. Все эти возможности присутствуют и

в других аналогичных редакторах, отыс-

кать и применить их в HotDog не соста-

вит труда, поэтому останавливаться по-

дробно на них мы сейчас не будем. Одна-

ко следует обратить внимание на менее

типичные, но очень полезные возможно-

сти. Большинству знакома такая пробле-

ма, как удаление лишних пробелов для

уменьшения размера документа и, соот-

ветственно, ускорения его загрузки. Ведь

не секрет, что многие web-дизайнеры для

этой цели используют утилиты сторон-

них разработчиков, и очень приятно, ког-

да все необходимое имеется «в комплек-

те» («Format –> Convert –> Remove Carri-

age Returns»). Согласитесь, черный текст

на белом фоне выглядит не очень привле-

кательно, так что, безусловно, многим

будет полезна специальная цветовая пи-

петка («Format -> Quick Color»), дающая

возможность определить для любого цве-

та его шестнадцатеричное значение в па-

литре RGB и затем применить его к

шрифту или фону документа. Возможно-

сти программы в области конвертирова-

ния приятно удивляют. Можно, к приме-

ру, выделить какой-либо текст и одним

нажатием кнопки мыши превратить его в

таблицу («Format –> Convert –> Convert

Selection to Table»). 

ÑÎfl ıÛ‰ÓÊÌËÍÓ‚
После того как мы разобрались со струк-

турой и текстом, настало время посмот-

реть, как организована в HotDog работа

по графическому оформлению HTML-

документов. Здесь дан полный простор

для полета творческой мысли дизайнера.

К его услугам не только типичные и са-

мые основные опции, такие как вставка

изображений, но и приятные сюрпризы,

например мастер Flash («Tools –> Flash

Wizard»), который, как видно из назва-

ния, помогает обогатить документ совре-

менной векторной анимацией, приобре-

тающей благодаря простоте создания,

широте возможностей и быстроте загруз-

ки все большую популярность у web-раз-

работчиков. 

Но не забыт и старый добрый формат

GIF («Tools –> GifAnimator»). Чем радует

нас этот инструмент? Хотя бы тем, что те-

перь не нужно прибегать к посторонним

средствам, чтобы создать простенькую

анимацию. Конечно, никаких инстру-

ментов для рисования здесь нет, для этого

существуют тысячи соответствующих ре-

дакторов, однако объединить графичес-

кие файлы в нужную последовательность,

задать размер и частоту смены кадров

здесь возможно. Причем неважно, в ка-

ких форматах будут исходные картинки,

из которых мы составим анимацию, так

как они автоматически будут конвертиро-

ваны в GIF. Правда, здесь есть один курь-

езный момент: разработчики, родной

язык которых — голландский, забыли пе-

ревести на английский всплывающие

подсказки в некоторых местах, в данном

случае в GIF-аниматоре. 

Файлы можно сразу же и оптимизиро-

вать («Tools –> Gif File Optimize»). Этот

процесс можно и нужно контролировать,

чтобы не допустить явной потери качест-

ва изображений. Любителям украшать

страницы динамическими эффектами на-

верняка придется по вкусу соответствую-

щий инструмент («Format –> Dynamic

HTML Animation»). Правда, сгенериро-

ванные скрипты он помещает непосред-

ственно в тело документа, а не создает от-

дельный файл. В Интернете очень попу-

лярны сайты, представляющие собой

web-галереи. Для создания таких галерей

опять-таки приходится использовать спе-

циальные программы, которые к тому же

еще и не бесплатны. И здесь разработчики

пошли навстречу пожеланиям пользова-

телей, включив в программу генератор

web-галерей («Insert –> Image Thumbinail

Table»). Нужно будет лишь указать дирек-

торию, где мы собираемся хранить мини-

атюры, и директорию, где находятся ори-

гинальные графические файлы. Но на-

стоящим подарком являются созданные

сторонними программистами и включен-

ные в программу HotDog в качестве пла-

гинов замечательные утилиты Boomer и

Xara MenuMaker (см. врезку).

èÓÒÎÂ‰ÌËÂ ¯ÚËıË
Если уж мы так много говорим об опти-

мизации, отметим, что наряду с опцией

удаления лишних пробелов в документе,

о которой говорилось выше, в программе

присутствует и более радикальное средст-

во — сжатие HTML-кода («Tools –>

HTML Compressor»). Оно уже вносит из-

менения непосредственно в структуру тэ-

гов, переименовывая более длинные в

аналогичные, но обозначаемые короче,

например <p align=center> меняется на

<center>. Однако здесь следует быть

очень внимательным, так как не все бра-

узеры поддерживают такие сокращенные

тэги. Лучше сначала создать резервную

копию документа и уже с ней проводить

эксперименты. А уж если ошибка допу-

щена, быстро отыскать и исправить ее

можно с помощью инструментов Code

Explorer и HTML Navigator, позволяющих

как на ладони увидеть всю разметку

HTML-документа. 

7 å‡ÒÚÂ ÒÓÁ‰‡ÌËfl
ÌÓ‚Ó„Ó Ù‡ÈÎ‡

å‡ÒÚÂ ‡Á·ËÂÌËfl
ÒÚ‡ÌËˆ˚ Ì‡ ÙÂÈÏ˚

3

èÓÒÚÓÂÌËÂ
Ú‡·ÎËˆ ‚ HotDog

3

GifAnimator ÔÓÏÓÊÂÚ ÒÓ-
Á‰‡Ú¸ ÌÂıËÚÛ˛ ‡ÌËÏ‡ˆË˛

3
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Для взаимодействия и контакта с по-

сетителями, а также для удобства нави-

гации на web-страницах часто применя-

ются так называемые формы. Имеются в

виду кнопки различного назначения,

выпадающие списки, окошки для ввода

текста и т. п. Мы не будем подробно ос-

танавливаться на этом вопросе, так как

работа с формами организована в про-

грамме стандартно и типично. Но и

здесь новичкам на помощь придет везде-

сущий мастер, который проведет их че-

рез весь процесс создания той или иной

формы и при этом снабдит каждый шаг

подробными пояснениями. 

К сожалению, многие сайты не отлича-

ются особой грамотностью, поэтому го-

товые HTML-документы никогда не по-

мешает проверить на предмет возможных

орфографических ошибок. HotDog пре-

доставляет такую возможность, но, к со-

жалению, пока только для английского

или голландского языков. Но это поло-

жение можно исправить, так как файлы

языков свободно подключаются к про-

грамме и могут быть созданы даже сто-

ронними разработчиками. 

Любой web-сайт после создания или

редактирования на локальном компью-

тере должен быть загружен на удален-

ный FTP-сервер. В составе HotDog так-

же присутствует многофункциональный

FTP-клиент. Благодаря ему можно не

только загружать на сервер готовые стра-

ницы, но также редактировать уже нахо-

дящиеся там («File -> Open Remote»). 

á‡ÍÎ˛˜ÂÌËÂ
Современные приложения предъявляют

порой очень высокие требования к сис-

темным ресурсам компьютера. Разработ-

чики при этом совершенно забывают,

что кто-то, возможно, все еще использу-

ет Pentium первого поколения. Однако

создатели HotDog постарались учесть не

только все вкусы своих пользователей,

но и системные возможности. Дело в

том, что даже на слабых машинах про-

грамма занимает не более 12% систем-

ных ресурсов и загружается моменталь-

но, что делает ее одним из самых быст-

рых современных HTML-редакторов. 

Как утверждают специалисты Sausage

Software, при разработке новых версий

HotDog они стараются учитывать все

пожелания пользователей. Попробуем и

мы высказать некоторые. К сожалению,

в редакторе отсутствует набор типовых

Java-скриптов и Java-апплетов, которы-

ми можно было бы оживить редактиру-

емую страничку. Ведь начинающим

web-дизайнерам бывает не так просто

создать свой собственный скрипт, и бы-

ло бы гораздо удобнее, если бы они ре-

дактировали уже существующие, учась

при этом на примерах. Несколько сум-

бурна и сама структура меню, и найти

нужную опцию бывает не так просто.

Но к этому вполне можно привыкнуть,

и в целом программа оставляет хорошее

впечатление. Конечно, многие возмож-

ности HotDog, такие как создание мак-

рокоманд, построение SQL-таблиц и

запросов, расширенный Буфер обмена

(до 20 фрагментов текста), остались за

рамками нашей статьи. Так что оставля-

ем за читателем право самостоятельно

изучить программу и совершить свои

открытия.

Наталия Крашенинникова

Плагины к HotDog Professional

Легкое творчество
К редактору HotDog можно подключать

различные плагины, расшириряющие

набор его функций. Но кое-что уже вклю-

чено в дистрибутив самими разработчи-

ками. В седьмой версии нас ожидает

знакомство с двумя, вернее тремя утили-

тами, специально предназначенными для

визуального оформления сайтов. Первые

две — Boomer Audio и Boomer Video —

обогатят страницы звуковыми и визуаль-

ными flash-эффектами. Boomer Audio кон-

вертирует звук, а Boomer Video создает

целое слайд-шоу из графических файлов,

к которым при этом могут быть примене-

ны разнообразные эффекты (поочередное

проявление картинок на экране, непре-

рывная «карусель» и т. д.), и сохраняет

его с расширением SWF. Одновременно

генерируется и HTML-файл, в который

уже встроен SWF. Итак, даже совершенно

не знакомый с Macromedia Flash пользо-

ватель без труда за считанные минуты

сможет создать свою первую flash-пре-

зентацию. 

Вторая утилита MenuMaker разработана из-

вестной британской компанией Xara. Мно-

гим уже хорошо знаком ее пакет WebStyle,

позволяющий визуально, с помощью под-

бора цвета, текстур и шрифтов создавать

из имеющихся нескольких сотен шаблонов

свои неповторимые элементы оформления

web-страницы, такие как трехмерные над-

писи, логотипы, фон, меню и кнопки. За ко-

роткий срок эта программа приобрела бе-

шеную популярность в сетевом сообществе

благодаря небывалой легкости и быстроте,

с которой можно было делать графику для

сайта. И MenuMaker является как раз час-

тью этого большого пакета, отвечающей за

создание элементов навигации.
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